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SMaRT AFIX for Independent 

States Installation Instructions 
The SMaRT AFIX for Independent States release was requested by the AFIX-IIS 

Integration Project Consortium and primarily enables Awardee testing to proceed in 

states with critical timelines and no integration with IWeb. 

The following provides an overview of the process for installing the SMaRT AFIX 

application. 

Components 

SMaRT AFIX is composed of several server components. The following includes their 

functions and brief technical descriptions. 

Standalone Forecaster (SAF) 

SAF is a web application that evaluates patient and vaccination data to produce a 

vaccination forecast for that patient. It provides both a user interface and a SOAP web 

service. For SMaRT AFIX, only the web service is used. 

SAF runs under Apache Tomcat 7.0 and is deployed as a .war file. It utilizes an Oracle 

Express Database (XE) to store pre-configured vaccination schedules and 

configuration data. 

Standalone Forecaster is installed on the Service box. 

PostgreSQL 

SMaRT AFIX utilizes PostgreSQL 9.4 as a database. An additional Postgres module, 

pg_partman, is required. The name of the database is afixdb. It is created via several 

.sql scripts. See SMaRT AFIX Database Initialization - Linux or Windows for the 

installation instructions. 

JasperReports Server (JRS) 

JRS is a web application that provides the reports for SMaRT AFIX. These reports are 

imported into JRS via the JRS Management Console. See SMaRT AFIX JasperReports 

Deployment - Linux or Windows for installation instructions. 

Jaspersoft ETL (JETL) 

Patient, vaccination, and provider data are batch-loaded into the SMaRT AFIX 

database on a nightly basis. Once this data has loaded, it is run through the 

Standalone Forecaster and aggregated into tables that are designed for reporting. 

These batch processes are scheduled and executed by Jaspersoft ETL. 
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SMaRT AFIX Application 

The UI and application server logic are provided via the SMaRT AFIX application. This 

is a Node.js application and uses Keycloak for user authentication. 

Keycloak 

User authentication is provided by Keycloak. It is used by all STC Suite applications 

for Single Sign-On (SSO). Each application requires a client within Keycloak. The 

client contains references (URLs, ports, etc.) that are specific to each individual 

SMaRT AFIX application. 

New Application Installations 

The following refers to new application installations, not necessarily to upgrade 

installations. The instructions differ between Linux and Windows installations as well. If 

you are building a new Linux Server, see the Build a Linux (CentOS) Server instructions. 

NOTE: The SMaRT AFIX components should be installed in the order listed below. 

Component Server Linux Windows 

Keycloak Installation Service 
(SVC) 

See either Keycloak Installation Guide for 
STC-Hosted Clients or Keycloak Installation 
Guide for Self-Hosted Clients. 

Standalone Forecaster Service 

(SVC) 

Forecaster 

Installation 

Instructions - Linux  

Forecaster Installation 

Instructions - 

Windows 

PostgreSQL Server (if not already 

installed) 

Database 

and Batch 
(DBB) 

Postgres Database 

Installation - Linux  

Postgres Database 

Installation - Windows 

SMaRT AFIX Database Database 
and Batch 
(DBB) 

SMaRT AFIX 
Database 
Initialization - Linux  

SMaRT AFIX Database 
Initialization - 
Windows 

SMaRT AFIX Online Tool Service 
(SVC) 

SMaRT AFIX Online 
Tool Web Service 
Installation 
Instructions - Linux 

SMaRT AFIX Online 
Tool Web Service 
Installation 
Instructions - 
Windows 

Jaspersoft ETL Server (if not already 
installed) (NOTE: Initial ETL loads can 

take several days; it's recommended 
to have them running while other 
components are being installed.) 

Database 
and Batch 

(DBB) 

Jaspersoft ETL 
Installation - Linux 

Jaspersoft ETL 
Installation - Windows 

SMaRT AFIX ETL Database 
and Batch 
(DBB) 

SMaRT AFIX 
Jaspersoft ETL 
Deployment - Linux 

SMaRT AFIX 
Jaspersoft ETL 
Deployment - 
Windows 

JasperReports Server (if not already 
installed) 

Application 
(APP) 

JasperReports Server 
Installation - Linux 

JasperReports Server 
Installation - Windows 

https://stchome.atlassian.net/wiki/display/iQ1175RD/IQ%2bDatabase%2bInitialization%2bLinux
https://stchome.atlassian.net/wiki/display/iQ1175RD/IQ%2bDatabase%2bInitialization%2bLinux
https://stchome.atlassian.net/wiki/display/iQ1175RD/IQ%2bDatabase%2bInitialization%2bLinux
https://stchome.atlassian.net/wiki/display/iQ1175RD/IQ%2bDatabase%2bInitialization%2bLinux
https://stchome.atlassian.net/wiki/display/iQ1175RD/IQ%2bDatabase%2bInitialization%2bLinux
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Component Server Linux Windows 

SMaRT AFIX Reports Application 
(APP) 

SMaRT AFIX 
JasperReports 
Deployment - Linux  

SMaRT AFIX 
JasperReports 
Deployment - 
Windows 

Node.js Server (if not already 
installed) 

Application 
(APP) 

Node.js Installation - 
Linux 

Not supported 

SMaRT AFIX Application Installation Application 
(APP) 

SMaRT AFIX 
Application 
Installation 
Instructions - Linux  

SMaRT AFIX 
Application 
Installation 
Instructions - 

Windows 

Keycloak Configuration for SMaRT 

AFIX 

Service 

(SVC) 

Keycloak Configuration for SMaRT AFIX 

(Linux and Windows)  

 



 

  

SMaRT AFIX (v. July 2019) for Independent Partners Installation Guide Page 4 

 

Windows Instructions 
The following instructions are for the Windows operating system. 

Forecaster Installation Instructions - 
Windows 

The installation of the Standalone Forecaster (SAF) is composed of three major tasks: 

install Oracle Express, install the SAF database into Oracle Express, and install the 

Forecaster web application into Tomcat. All three components are installed on the Service 

machine (SVC). 

SAF can be installed to Oracle 11g or Oracle Express 11g. The Oracle product you choose 

will depend on your state's licensing. Oracle Express 11g is free to use for this type of 

installation. All performance testing, etc., for SAF has been conducted using Oracle 

Express. These instructions only cover the installation of Oracle Express 11g. 

Install Oracle Express 

1. If necessary, create an Oracle account at http://www.oracle.com. 

2. If using Oracle Express (free), download the appropriate version. The Windows 

version is approximately 312MB in size. 

3. Unzip the downloaded file and run the DISK1/setup.exe. When using the 

installation wizard, the installer creates a database named XE. The installer uses 

these ports: TNS = 1521, MTS = 2030, HTTP = 8080. 

4. There may be two error messages about a missing file named KEY_XE.reg. Just 

acknowledge them and continue with the installation. 

5. Disable the HTTP port by running the following at a command prompt after the 

installation is complete: 

echo EXEC DBMS_XDB.SETHTTPPORT(0); | sqlplus / as sysdba 

http://www.oracle.com/
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Install the SAF Database (New Installation) 

Database objects are created with 5.16.9 CDSi install version. 

1. Navigate to the 

/SVC/OXE/db/AFIX_CDSI_Install/AFIX_CDSI_v5.16.9_Install/ directory. 

2. Run Install.bat. 

3. Navigate to the /SVC/OXE/db/Patches/patch_v5_17_CDSI directory. 

4. Run the forecast.bat script. 

5. Navigate to the /SVC/OXE/db/Patches/patch_v5_18_CDSI directory. 

6. Run the forecast.bat script. 

7. Navigate to the /SVC/OXE/db/Patches/AFIX_March_2019 directory. 

8. Run the forecast.bat script. 

 

Run Database Patches (Upgrades) 

1. Navigate to the /SVC/OXE/db/Patches/AFIX_March_2019 directory. 
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2. Run the forecast.bat script. 

Install the Web Application 

Before installing the SMaRT AFIX web application, Java 7 must be installed on the SVC 

server and Tomcat 7.0 must also be installed and running on the SVC server. 

1. Edit the conf/context.xml file - Add the lines below (between the 

<Context></Context> tags) to the CATALINA_HOME/conf/context.xml file. The 

added lines should be placed within the <Context></Context> tags in the file. 

<Context> 

   <Resource name="jdbc/com/stc/forecaster" 

   auth="Container" 

   type="javax.sql.DataSource" 

   driverClassName="oracle.jdbc.OracleDriver" 

   url="jdbc:oracle:thin:@localhost:1521/XE" 

   username="SAFUSER" 

   password="SAF" 

   maxActive="100" 

   maxIdle="10" 

   maxWait="-1"/> 

</Context> 

2. Copy the /SVC/SAF/forecaster.war to webapps/forecaster.war under your 

Tomcat directory. 

3. Restart Tomcat. 

4. Set the number of threads to the number of processor cores available on your 

server - Edit $CATALINA_HOME/webapps/forecaster/WEB-INF/spring-ws-

servlet.xml and set the thread count (see the second line of code below): 

<bean id="forecastingEndpoint12" 

class="com.stchome.saf.ws.endpoint.ForecasterServiceEndpoint12" 

scope="prototype"> 

   <constructor-arg value="1" /><!-- Thread count --> 

   <constructor-arg value="60" /><!-- Thread pool termination timeout in 

seconds--> 

</bean> 

5. Restart Tomcat. 

6. Verify the application is running correctly by navigating to http://[YOUR 

SERVER]/forecaster. The UI displays if the application was successfully installed 

and configured. 
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Postgres Database Installation - Windows 

The information below describes how to install the Postgres database on Windows Server 

2008 R2 64-bit, as well as how to modify relevant Postgres server configuration settings 

for SMaRT AFIX. 

Install on Windows 

The following information covers general installation instructions for installing PostgreSQL 

on Windows. Windows Server 2008 R2 64-bit was used as a reference, but installation on 

other versions of Windows should be similar. 

1. Visit this page and download the latest 64-bit version of Postgres. Version 9.4.x 

was used for this installation example. 

https://www.enterprisedb.com/downloads/postgres-postgresql-downloads#windows
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2. Run the downloaded executable to start the installation. It is recommended to use 

the default installation directories, but they can be customized as needed (make 

note of the new locations). 

3. Choose a password for the Postgres admin user postgres and store it securely for 

when administrative maintenance is required. 

4. Use the default port 5432 (recommended). An alternate port can be used, but 

make sure to configure connecting applications to the Postgres database. 

5. Use the default locale. 

6. On the last step post installation, you can uncheck the Stack Builder may be... 

option and click Finish. 

Modify Postgres Server Configuration Settings 

Some of the Postgres server configuration settings must be modified. If you used the 

default installation directory, the following file reference locations should be located in 

the directory path: 

C:\Program Files\PostgreSQL\9.4\data\ 

1. Edit the pg_hba.conf file to allow connections from other STC 

servers/applications. Copy/paste the following line: 

host   all      all      127.0.0.1/32      md5 

to make the file look something like the following. Let's assume your internal sub-

net falls under 192.168.x.x, which would update the line to: 

host   all      all      127.0.0.1/32         md5 

host   all      all      192.168.0.0/16       md5 
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Save the changes. If you are technical and familiar enough with CIDR notation, 

you can further customize and restrict connection access as needed. 

2. Trigger Postgres to reload with the new configuration changes by running Reload 

Configuration, found under PostgreSQL 9.4 in the Windows Start Menu: 

 

 

3. Create a custom firewall rule to allow inbound connections on port 5432: 

 

 

4. Complete the installation by initializing the database (see SMaRT AFIX Database 

Initialization - Windows). 
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SMaRT AFIX Database Initialization - 
Windows 

The information below describes how to initialize the database for the first time, how to 

upgrade/migrate an existing database, and how to set up daily jobs.  

Prerequisite Tasks 

Perform the following tasks before initializing the database: 

1. Confirm that PostgreSQL has been installed. 

2. State-specific eligibility: If your state uses one or more state-specific codes for 

VFC eligibility, you will need to make a modification to the 
/DBB/POSTGRES/sql/OLAP/OLAP_V1_0_2__R1_Afix_OLAP_Initial_Data.sql 

file. Add the state-specific codes to the DIM_VFC_ELIGIBLE section as noted 

below. Be sure to increment the vfc_eligible_key value for each state-specific 

code you add. State-specific codes should be added exactly as they appear in 

your system database.  

... --DB_script for DIM_VFC_ELIGIBLE---- 

   INSERT INTO olap.dim_vfc_eligible(vfc_eligible_key, 

vfc_eligible_code, created_ts) 

   VALUES (1, 'Not VFC Eligible-Underinsured', current_timestamp), 

      (2, 'VFC Eligible - State Specific Eligiblity', 

current_timestamp), 

      (3, 'Local-Specific Eligiblity', current_timestamp), 

      (4, 'Not VFC Eligible', current_timestamp), 

      (5, 'American Indian/Alaska Native', current_timestamp), 

      (6,'Uninsured', current_timestamp), 

      (7,'Federally Qualified Health Center patient', 

current_timestamp), 

      (8,'Medicaid', current_timestamp), 

--Add State Codes here---- 

      (9, 'State Specific Code', current_timestamp), 

      (-1,'Unknown', current_timestamp); 

... 

Initialize a New Database (for the First Time Only) 

If this is the first time you are initializing the database, follow the steps below. 

Otherwise, see the Upgrade/Migrate an Existing Database instructions. 

1. Create a tablespace folder - Use Windows Explorer to create the directory for the 

tablespace to be used by SMaRT AFIX. Navigate to the folder C:\Program 

Files\PostgreSQL\9.4, click the New Folder button, and name the new folder 

afixdb. 

2. Set the folder permissions for afixdb - In Windows Explorer, right-click on the 

afixdb folder and select Properties. Click on the Security tab, then click the Edit 
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button and then the Add button. Enter the name network service and click on the 

Check Names button. 

3. Your window should like the image below, although your location will be different 

and local to your network. Click OK. 

 

 

4. Make sure NETWORK SERVICE is selected and that the Full Control option under 

the Allow column is selected. When finished, click OK for all of the remaining 

open windows to close them. 
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5. Create the data directory: 

C:\Program Files\PostgreSQL\9.4\afixdb\data 

6. Create the olapdata directory: 

C:\Program Files\PostgreSQL\9.4\afixdb\olapdata 
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7. Download the release distribution zip file and extract the database scripts for the 

database server in the afixdb folder: 

\DBB\POSTGRES 

8. Create the afixdb by navigating to the /DBB/POSTGRES directory and executing the 

following command. If prompted, enter the password that was entered during the 

Postgres installation. 

"c:\Program Files\PostgreSQL\9.4\bin\psql.exe" -Upostgres -f 

setup_database_win.sql 

9. Create the database users and roles by navigating to the /DBB/POSTGRES 

directory and executing the following command. If prompted, enter the password 

that was entered during the Postgres installation. 

"c:\Program Files\PostgreSQL\9.4\bin\psql.exe" -Upostgres -f 

setup_objects.sql afixdb 

10. Create the APP configuration schema by navigating to the /DBB/POSTGRES 

directory and executing the following command. Enter the password AfixQA. 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -

sqlMigrationPrefix=APP_V -user=afix migrate 

11. Create the ODS schema by navigating to the /DBB/POSTGRES directory and 

executing the following command. Enter the password AfixQA.  

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -

sqlMigrationPrefix=ODS_V -user=afix migrate  

12. Create the OLAP schema by navigating to the /DBB/POSTGRES directory and 

executing the following command. Enter the password AfixQA. 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -

sqlMigrationPrefix=OLAP_V -user=afix migrate 

Upgrade/Migrate an Existing Database 

If this is not the first time you are initializing the database, follow the steps below. 

Otherwise, see the Initialize a New Database (for the First Time Only) instructions. 

1. Migrate the APP configuration schema by navigating to the /DBB/POSTGRES 

directory and executing the following command. Enter the password AfixQA. 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -

sqlMigrationPrefix=APP_V -user=afix migrate 

2. Migrate the ODS schema by navigating to the /DBB/POSTGRES directory and 

executing the following command. Enter the password AfixQA. 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
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sqlMigrationPrefix=ODS_V -user=afix migrate 

3. Migrate the OLAP schema by navigating to the /DBB/POSTGRES directory and 

executing the following command. Enter the password AfixQA. 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -

sqlMigrationPrefix=OLAP_V -user=afix clean 

 

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -

sqlMigrationPrefix=OLAP_V -user=afix migrate 

Set Up a Daily Job / Drop Partition 

1. Copy partition.sql and partition.bat from the /DBB/POSTGRES directory to 
C:\Program Files\PostgreSQL\9.4\afixdb. 

2. Navigate to the /DBB/POSTGRES directory and execute this command: 

copy partition.sql C:\Program Files\PostgreSQL\9.4\afixdb  

copy partition.bat C:\Program Files\PostgreSQL\9.4\afixdb 

3. Create a Task Scheduler to run the C:\Program 

Files\PostgreSQL\9.4\afixdb\partition.bat script daily at 1:00 a.m. to 

create future partitions and drop old partitions. 

SMaRT AFIX Online Tool Web Service 
Installation - Windows 

The SMaRT AFIX Online Tool web service is used by the SMaRT AFIX application to 

generate an XML file to be uploaded to the CDC's AFIX online tool application. The web 

service is a simple web application that is installed alongside the Stand Alone Forecaster 

on the Service machine (SVC). 

Prerequisites 

1. The Postgres database is installed and configured. 

2. The Postgres password for the SMaRT AFIX database is known. 

3. The Tomcat instance is installed on the SVC server. 

4. All necessary ports are open across all firewalls. 

5. The release distribution file for the SMaRT AFIX Online Tool web service is 

extracted from /SVC/ONLINE_TOOL/afix.export.ws.war and copied to your local 

drive. 
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Installation Steps 

1. Copy the afix.export.ws.war file to your Tomcat webapps folder. 

2. Restart Tomcat. 

3. Update the application properties to point to the proper Postgres database. Make 

sure the username and password are correct. 

4. Edit the $CATALINA_HOME/webapps/afix.export.ws/WEB-INF/app.properties 

file: 

driverClassName=org.postgresql.Driver 

url=jdbc:postgresql://127.0.0.1:5432/afixdb 

username=afixUser 

password=afixPassword 

5. Restart Tomcat. 

Jaspersoft ETL Installation - Windows 

Follow these instructions to install Jaspersoft ETL, Apache Web Server, and Subversion, 

and to configure the administration console. This installation only needs to occur once. 

Prerequisites 

1. Java JDK 8 (1.8.91) has been installed. 

2. The environment variable JAVA_HOME has been set: 

JAVA_HOME=[drive]:\directory\Java\1.8_91 

3. Copy the components from the distribution /Server Components/ETL directory 

into your local directory. These files include:  

 license.txt 

 TIBCOJaspersoft-JETL-Installer-20150908...zip 

 etl.zip 

Install Jaspersoft ETL 

1. Download the Jaspersoft ETL installer zip file and the license file: 

Server Components\ETL\TIBCOJaspersoft-JETL-Installer-20150908_1633-

V7.1.1-installer.zip 

Server Components\ETL\license.txt 

2. Copy the installer and license file into a temporary directory: 
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c:\user\[user name]\Downloads 

3. Unzip the installer into the temporary directory. Several files will be extracted. 

Keep all of the files in the temporary directory for the duration of the installation. 

4. From the temporary directory, execute the Windows installer by clicking on:  

TIBCOJaspersoft-JETL-Installer-20150908_1633-V7.1.1-windows-

installer.exe 

5. Follow the prompts to accept the license agreement. 

6. Follow the prompts to specify the installation directory, installation type, and 

license file. Specify [drive:]\Jaspersoft\7.1.1 for the installation directory, 

Easy Install for the installation type, and license.txt (found in the temporary 

directory). 

7. Click the Next button and wait until the installation finishes. 

8. Click the Start button, search for services.msc, and then search for any service 

named TIBCO Jaspersoft Logserver Collector 7.1.1.  Stop this service and set it to 

Manual. If there is no service named this, ignore this step.  

Start/Stop Jaspersoft ETL Services 

The following are the instructions to start and/or stop Jaspersoft ETL services. These 

steps are not mandatory on a first-time installation because the services will be running 

by default. 

Start/Stop Jaspersoft ETL Admin Console 

Command to stop the service: 

$ cd C:\Jaspersoft\7.1.1\jac 

$ stop_tac.bat 

Command to start the service: 

$ cd C:\Jaspersoft\7.1.1\jac 

$ start_tac.bat 

Start/Stop Jaspersoft ETL Command Line 

Command to stop the service: 

$ cd C:\Jaspersoft\7.1.1\cmdline 

$ stop_cmdline.bat 

Command to start the service: 

$ cd C:\Jaspersoft\7.1.1\cmdline 

$ start_cmdline.bat 
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Start/Stop Jaspersoft ETL Job Server 

Command to stop the service: 

$ cd C:\Jaspersoft\7.1.1\jobserver 

$ stop_jobserver.bat 

Command to start the service: 

$$ cd C:\Jaspersoft\7.1.1\jobserver 

$ start_jobserver.bat 

Configure the Admin Console 

These steps are used one time only. They should be completed during the server 

installation. 

1. Navigate to http://[host name]:8080/org.jasper.administrator and enter 

the default username and password (admin). For the username, use 

admin@yourdomain.com or replace it with an email group if the user needs email 

notifications on ETL job failure (example: email_group@yourdomain.com). 

2. Navigate to User Settings on the left menu and update the username (if 

needed) and library information. 
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3. Click on Role and select all of the roles. 

 

 

4. Navigate to Project settings from the left menu and add a new project by 

clicking the Add button. 

5. Name the project as AFIX_ETL, select the Active option, enter AFIX_ETL as the 

description and admin admin as the Author, select None as the storage, and 

save it. 

 

 

6. Navigate to Project authorization from the left menu. Click on each of the 

newly created projects and assign read/write permissions to the user. 
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7. Create the following directories and files in the server: 

C:\Jaspersoft\7.1.1\deploy 

C:\Jaspersoft\7.1.1\deploy\generatedJobs 

C:\Jaspersoft\7.1.1\deploy\executionLogs 

C:\Jaspersoft\7.1.1\cmdline\exports 

C:\Jaspersoft\7.1.1\Audit 

C:\Jaspersoft\7.1.1\Audit\reports 

C:\Jaspersoft\7.1.1\joblogs 

C:\Jaspersoft\7.1.1\joblogs\log.txt 

8. In Primary Command Line configuration, set the path for the Job generation folder 

to C:/Jaspersoft/7.1.1/cmdline/exports 

 

 

9. In Job Conductor configuration, set the path for the Generated jobs folder to 

c:/Jaspersoft/7.1.1/deploy/generatedJobs and the path to the Tasks logs 

folder to c:/Jaspersoft/7.1.1/deploy/executionLogs 
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10. In Logging configuration, set the Technical log file path to 
c:/Jaspersoft/7.1.1/joblogs/log 

 

 

11. In Audit configuration, set the Reports stored path to 
c:/Jaspersoft/7.1.1/Audit/reports 

 

 

12. Navigate to Servers page from the menu and create a new execution server with 

the following settings:  

 Label: Name of the job server 

 Host: ETL Server IP (it usually ends with dbb) 

 Command port: 8000 

 File transfer port: 8001 

 Monitoring port: 8888 

 Active: Select this option (enable) 

 Username: the admin username for the ETL 

 Password: the password for the admin ETL user 
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13. Log in via Remote Desktop to Windows Server using ETL server owner. 

14. Copy the etl.zip file (from /DBB/ETL) to a location convenient for you on the 

ETL Jaspersoft server to unzip the file, such as a home directory. 

15. Unzip the etl.zip file to the server in (C:\) directory (Windows), which creates a 

directory structure similar to this: 

 C:\etl 

 C:\etl\data 

 C:\etl\archive 

  

SMaRT AFIX Jaspersoft ETL Deployment - 
Windows 

The following outlines how to import (migrate) Jaspersoft ETL for SMaRT AFIX. 
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Pre-Migration Checklist 

 Confirm that the Postgres database is installed and configured 

 Retrieve the passwords for the SMaRT AFIX database (afixdb) 

 Retrieve the Jaspersoft ETL admin username and password 

 Confirm that port 8080 is open across all firewalls 

 Confirm that all of the steps in the Admin Console configuration are completed on 

a first-time installation 

 Copy these components from /DBB/ETL into your local directory:  

 API_Vaildation_Sequential_Execution_0.1 

 etl 

 etl_201703 

 Forecaster_Sequential_Execution_0.1 

 ODS_Sequential_Execution_0.1 

 OLAP_Sequential_Execution_0.1 

 AFIX_Assessment_Benchmark_0.1 

 UserApi_Sequential_Execution_0.1 

 Place all of the API files in /etl/afix/api/ 

 The API_EXTRACT_Complete.tkn file should be placed along with the other API 

files so that it can help trigger ETL jobs. 

 Identify whether the installation is an upgrade from prior versions or a fresh 

installation from scratch.  

New Installation Instructions (for the First Time Only) 

If this is the first time you deploying Jaspersoft ETL, follow the steps below. Otherwise, 

see the Upgrade Instructions. 

The steps below only need to be performed once. They should be completed during the 

server installation. 

Configure the Admin Console 

1. Navigate to http://[host name]:8080/org.jaspersoft.administrator and 

enter the default username and password (admin). For the username, use 

admin@yourdomain.com or replace it with an email group if the user needs email 

notifications on ETL job failure (example: email_group@yourdomain.com). 

2. Navigate to Project settings from the left menu and add a new project by 

clicking the Add button. 

3. Name the new project AFIX_ETL. Select the Active option, enter admin admin 

as the Author, and select NONE as the Storage. 
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4. Navigate to Project authorization from the left menu. Click on the newly 

created project and assign read/write permission to the user. 

 

 

5. Navigate to Servers page from the menu and create a new execution server with 

the following settings:  

 Label: AFIX_jobServer 

 Host: ETL Server IP (it usually ends with dbb) 

 Command port: 8000 

 File transfer port: 8001 

 Monitoring port: 8888 

 Active: Select this option (enable) 

 Username: the admin username for the ETL 

 Password: the password for the admin ETL user 
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6. Log in via SSH to the Unix server using the ETL server owner. 

7. Copy the etl.zip file (from /DBB/ETL) to a location convenient for you on the 

ETL Jaspersoft server to unzip the file, such as a home directory. 

8. Unzip the etl.zip file to the server in the root directory (Unix), which creates a 

directory structure similar to this: 

 c:\etl\afix 

 c:\etl\afix\api 

 c:\etl\afix\archive 

 c:\etl\afix\bulkload 

 c:\etl\afix\dataout 

 c:\etl\afix\input 

 c:\etl\afix\rejects 

 c:\etl\afix\tmp 

 c:\etl\afix\validation 
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Deploy the ETL Components 

1. If a previous ETL Projects already exists, perform a backup of it. 

2. Copy the following files from the installation files to a convenient location to 

deploy:  

 UserApi_Sequential_Execution.zip 

 API_Validation_Sequential_Execution.zip 

 ODS_Sequential_Execution.zip 

 Forecaster_Sequential_Execution_0.1.zip 

 OLAP_Sequential_Execution.zip 

 AFIX_Assesment_Benchmark.zip 

 AFIX_Manage_Partition_0.1 

3. Navigate to the Job Conductor page. 

4. Select Add > Normal Task and add the following: Label = User API Execution; 

Description = User API Execution. 

5. Click Import Generated Jobs and select the 

UserApi_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

6. Click Save. 

7. Navigate to the task AFIX IWeb API Validation. 

8. Select Add > Normal Task and add the following: Label = AFIX IWEB API 

Validation; Description = AFIX IWEB API Validation. 

9. Click Import Generated Jobs and select the 

API_Validation_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

10. Click Save. 

11. Select Add > Normal Task and add the following: Label = AFIX Stage 2 ODS 

Load; Description = AFIX Stage 2 ODS Load. 

12. Click Import Generated Jobs and select the 

ODS_Sequential_Execution.zip file downloaded as part of the prerequisites. 

Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer 

= Recover Task. 

13. Click Save. 
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14. Select Add > Normal Task and add the following: Label = AFIX Forecast 

Execution; Description = AFIX Forecast Execution. 

15. Click Import Generated Jobs and select the 

Forecaster_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

16. Click Save. 

17. Select Add > Normal Task and add the following: Label = AFIX OLAP Execution; 

Description = AFIX OLAP Execution. 

18. Click Import Generated Jobs and select the 

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites. 

Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer 

= Recover Task. 

19. Click Save. 

20. Select Add > Normal Task and add the following: Label = AFIX Assessment 

Benchmark; Description = AFIX Assessment Benchmark. 

21. Click Import Generated Jobs and select the 

AFIX_Assessment_Benchmark.zip file downloaded as part of the prerequisites. 

Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer 

= Recover Task. 

22. Click Save. 

23. For each job created above, edit c:\etl\afix\input\contextFile.txt and update the 

below details 

 Email_To 

 Email_SMTP_Host 

 Email_SMTP_Port 

 AFIX_Email_Notification 

 Email_Active 

 Email_UserName 

 Email_Password 

 Web service related parameters (Forecaster):  

 SOAP_ACTION 

 ENDPOINT 

 Database-related parameters:  

 AFIX_DB - Login, Password, Port, Database, and Server 
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 Source_DB_Context - Login, Password, Port, Database, and Server 

 RDS-related parameters for ODS_sequential_job  

 Psql_Path - Path of the psql (by default, it is /usr/pgsql-9.4/bin) 

 Rds_Postgres - A boolean parameter; set it to True if the database is 

RDS 

 Windows_Execution_Environment - A boolean parameter; set it to 

False; the ID of the ETL execution environment is UNIX. 

24. Save when finished. 

25. Initial load instructions:  

 Run the AssessmentBenchmark task 

 Go to the task IWeb API Validation and add a file trigger with the 

following values: Label = TriggerValidationAPI, Folder Path = /etl/afix/api, 

File Mask = START_ETL_RUN.tkn , Pollint(s) = 200 

 

 

 

 Go to the task AFIX Stage 2 ODS Load and add a file trigger with these 

values: Label = TriggerODSLoad, Folder Path = /etl/afix/dataout, File Mask 

= API_VALIDATION_Complete.tkn, Pollint(s) = 200 
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 Go to the task AFIX Forecast Execution and add a file trigger with the 

following values: Label = TriggerForecast, Folder Path = /etl/afix/dataout, 

File Mask = API_LOADS_TO_ODS_Complete.tkn, Pollint(s) = 200. Add the 

JVM parameters -Xms1024M and -Xmx15690M 

 

 

 Go to the task AFIX OLAP Execution and add a file trigger with the 

following values: Label = TriggerOLAP, Folder Path = /etl/afix/dataout, File 

Mask = Forecast_Loads_Complete.tkn, Pollint(s) = 200. Add the JVM 

parameters -Xms1024M and Xmx15690M 

 

 

 Go to the task UserApi Sequential Execution and add a file trigger with 

the following values: Label = TriggeruserAPI, Folder Path = 

/etl/afix/dataout, File Mask = OLAP Complete.tkn, Pollint(s) = 200. After 

that, run the task UserApi Sequential Execution. 
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26. Once the initial loads have completed, the ODS and OLAP tables are populated. 

Now the daily sequence can be scheduled. Go to the AFIX IWeb API Execution 

task and add the Cron trigger Trigger_IWeb_API. Enter the following values and 

save:  

 Timezone Strategy: TAC Time 

 Minutes: 0 

 Hours: 0 

 Days of Month: Leave blank 

 Months: 1,2,3,4,5,6,7,8,9,10,11,12 

 Days of the Week: 1,2,3,4,5,6,7 

 Years: leave blank 

 

 

 

27. Turn on the notify/email feature. Important Note: SMTP needs to be configured 

beforehand.  

 Select Notifications from the left menu 
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 Click Add 

 Select the Tasks category 

 Select On task failed 

 Select Enabled 

 Select Recipients to specify the user's email. It is better to create an 

email group as a recipient so that notifications are sent to multiple people 

 Select AFIX ETL Workflow 

 

If the upgrade needs to be aborted for any reason, import the previously created backup. 

Alternatively, redeploy the previous version of the content. 

Upgrade Instructions 

If this is not the first time you are deploying Jaspersoft ETL (i.e., it was deployed earlier), 

follow the steps below. Otherwise, see the New Installation Instructions. 

The steps below only need to be performed once. They should be completed during the 

server installation. 

Configure the Admin Console 

1. Navigate to http://[host name]:8080/org.jaspersoft.administrator and 

enter the default username and password (admin). For the username, use 

admin@yourdomain.com or replace it with an email group if the user needs email 

notifications on ETL job failure (example: email_group@yourdomain.com). 

2. Log in via SSH to the Unix server using the ETL server owner. 

3. Copy the etl.zip file (located at /DBB/ETL) to the Jaspersoft ETL server. Use a 

location convenient for you to unzip the file, such as a home directory. 

4. Unzip the etl.zip file to the server in the Unix root directory (Unix), which adds 

the following files that were created as part of this release:  

 c:\etl\afix 

 c:\etl\afix\api 

 c:\etl\afix\archive 

 c:\etl\afix\bulkload 

 c:\etl\afix\dataout 

 c:\etl\afix\input 

 c:\etl\afix\rejects 
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 c:\etl\afix\tmp 

 c:\etl\afix\validation 

Deploy the ETL Components 

1. If a previous ETL Projects already exists, perform a backup of it. 

2. Copy the following files from the installation files to a convenient location to 

deploy:  

 API_Validation_Sequential_Execution.zip 

 ODS_Sequential_Execution.zip 

 Forecaster_Sequential_Execution_0.1.zip 

 OLAP_Sequential_Execution.zip 

 AFIX_Assesment_Benchmark.zip 

 UserApi_Sequential_Execution_0.1 

3. Navigate to the Job Conductor page. 

4. Navigate to the task AFIX Assessment Benchmark. 

5. Click Import Generated Jobs and select the AFIX_Assessment_Benchmark.zip 

file downloaded as part of the prerequisites. Add the following: Execution server 

= AFIX_JobServer; On Unavailable JobServer = Recover Task. 

6. Click Save. 

7. Navigate to the task AFIX IWeb API Validation. 

8. Click Import Generated Jobs and select the 

UserApi_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

9. Click Save. 

10. Navigate to the task AFIX IWeb API Validation. 

11. Click Import Generated Jobs and select the 

API_Validation_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

12. Click Save. 

13. Navigate to the task AFIX Stage 2 ODS Load. 

14. Click Import Generated Jobs and select the 

ODS_Sequential_Execution.zip file downloaded as part of the prerequisites. 
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Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer 

= Recover Task. 

15. Click Save. 

16. Navigate to the task AFIX Forecast Execution. 

17. Click Import Generated Jobs and select the 

Forecaster_Sequential_Execution.zip file downloaded as part of the 

prerequisites. Add the following: Execution server = AFIX_JobServer; On 

Unavailable JobServer = Recover Task. 

18. Click Save. 

19. Navigate to the task AFIX OLAP Execution. 

20. Click Import Generated Jobs and select the 

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites. 

Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer 

= Recover Task. 

21. Click Save. 

28. For each job created above, edit c:\etl\afix\input\contextFile.txt and update the 

below details 

 Email_To 

 Email_SMTP_Host 

 Email_SMTP_Port 

 AFIX_Email_Notification 

 Email_Active 

 Email_UserName 

 Email_Password 

 Web service related parameters (Forecaster):  

 SOAP_ACTION 

 ENDPOINT 

 Database-related parameters:  

 AFIX_DB - Login, Password, Port, Database, and Server 

 Source_DB_Context - Login, Password, Port, Database, and Server 

 RDS-related parameters for ODS_sequential_job  

 Psql_Path - Path of the psql (by default, it is /usr/pgsql-9.4/bin) 

 Rds_Postgres - A boolean parameter; set it to True if the database is 

RDS 
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 Windows_Execution_Environment - A boolean parameter; set it to 

False; the ID of the ETL execution environment is UNIX. 

22. Save when finished. 

23. Initial load instructions: Go to the task AFIX IWeb API Execution. Run the task 

and wait to see if the job executes without any issues. Once it has made 

progress, make sure each of these tasks is triggered and completes:  

 IWeb API Validation 

 State 2 ODS Load 

 Forecast Execution 

 OLAP Execution 

24. Once the initial loads have completed, the ODS and OLAP tables are populated. 

Now the daily sequence can be scheduled. Resume the CRON trigger 

Trigger_IWeb_API. Go to the task OLAP_Sequential_Execution and change the 

context parameter custom date to the original value in 

OLAP_Sequential_Execution and save. 

If the upgrade needs to be aborted for any reason, import the previously created backup. 

Alternatively, redeploy the previous version of the content. 

JasperReports Server Installation - 
Windows 

The following instructions explain how to install the JasperReports Server on Windows. 

Prerequisite 

Download all of the JasperReports Server contents from the distribution site. The JRS 

folder contains the following files: 

 applicationContext-externalAuth-oAuth 

 applicationContext-security 

 applicationContext-security-web 

 InstallCert$SavingTrustManager.class 

 InstallCert.class 

 jasperreports-server-7.1.1-windows-64bit-installer.exe 

 jasperserver.license 

 LatoFont 

 stc-jaspersoft-oauth-0.0.1-SNAPSHOT 
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Installation Steps 

1. Download the JasperReports Server for Windows and the license file from the 

release distribution: 

Server Components\JRS\jasperreports-server-7.1.1-windows-64bit-

installer.exe 

Server Components\JRS\jasperserver.license  

2. Run the JasperReports Server Installer by right-clicking on the file and selecting 

Run as administrator: 

jasperreports-server-7.1.1-windows-64bit-installer.exe  

3. Follow the prompts to accept the license agreement. 

4. Select the Install All Components and Samples option. 

5. Follow the prompts to specify the installation folder. Specify the following 

directory: 

C:\Jaspersoft\jasperreports-server-6.2 

6. On completion of the installation, start the JasperReports server by selecting the 

following: 

Launch JasperReports Server Now (for bundled Tomcat and PostgreSQL only) 

If you’re installing on Linux, don't close the terminal window running 

the start script. 

7. Validate the installation by logging in to the JasperReports Server console. Use 

your browser to access the server. Replace <hostname> below with the name or 

IP address of the server: 

http://<hostname>:8080/jasperserver-pro 

8. Log in with the user ID of superuser and the default password of superuser. 
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Update the License File 

Follow these steps to update the license file for the JasperReports server: 

1. Copy the license file (jasperserver.license) from the distribution site and move 

it to your home directory/desktop. 

2. Replace the license file in the JasperReports installation directory 

(C:\Jaspersoft\jasperreports-server-6.2\) with the license file from the 

above step, overwriting the existing jasperserver.license file. 

3. Restart the JasperReports server (see Start/Stop the JasperReports Server 

below). 

Increase the JasperReports Session Timeout Period 

By default, the JasperReports timeout period is set to 20 minutes. However, the timeout 

period should be reset to 32 minutes in order to match with Keycloak. 

1. Open web.xml from the path C:\Jaspersoft\jasperreports-server-

6.2\apache-tomcat\webapps\jasperserver-pro\WEB-INF\web.xml. 

2. Search for the property <session-timeout> under <session-config> and update 

the value to 32. After this, the property and value should be similar to the image 

below: 

 

 

3. Restart the JasperReports server (see Start/Stop the JasperReports Server 

below). 
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Start/Stop the JasperReports Server 

To start or stop the JasperReports server, click the Start button, go to All Programs > 

JasperReports Server > Start or Stop Services, and then select either Start Service 

or Stop Service. 

JasperReports Configuration with Keycloak 

A few configuration changes need to be made in order for JasperReports to be used with 

Keycloak. 

Prerequisite 

Keycloak must be installed and set up, if the SSO-enabled version of IWeb and VOMS is 

being used. 

JasperReports Server Modifications 

1. Edit the following values in the applicationContext-externalAuth-oAuth.xml 

file: 

Key XML Tag 

Name(s) to 

Update 

Value 

[KEYCLOAK_URL] <authorization_loca
tion> 

<token_location> 

<userdetails_locati
on> 

<logoutUrl> 

URL of the Keycloak server. 
Example:  https://sso-dev.stchome.com/ 

[KEYCLOAK_REALM] <authorization_loca
tion> 

<token_location> 

<userdetails_locati
on> 

<logoutUrl> 

Keycloak realm that the client belongs to. This 
value needs to be changed, along with 
<keycloak_URL>.  

In this example, the realm name is Dev-
Integration: https://sso-
dev.stchome.com/auth/realms/Dev-

Integration 

[JASPERSERVER_URL] <property 
name="redirecturl"

> 

<property 

name="logoutUrl"> 

URL of the Jasper server. Example: 
http://<server_name>:8080/jasperserver-

pro/oauth 

[CLIENT_ID] <property 

name="client_id"> 

Client ID as set on Keycloak. Example: 

<property name="client_id"> 
<value>jasper-aws-dev</value> 

[CLIENT_SECRET] <property 
name="clientsecret

Credentials secret key generated by Keycloak. 
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Key XML Tag 

Name(s) to 

Update 

Value 

"> 

<property 
name="userdetails

_secret"> 

State_ID <property 

name="state"> 

This is the global setting used to populate the 

STATE_ID attribute in Jaspersoft. Example: 

<bean id="oAuthUserDetailsService" 
class="com.jaspersoft.jasperserver.ps.OAuth.OAut
hUserDetailsServiceImpl"> 
<property name="state"> 
<value>WA</value> 

</property> 

</bean> 

Jaspersoft Roles <bean 
id="mtExternalUser
SetupProcessor" 
class="com.jaspers
oft.jasperserver.mu
ltipleTenancy.securi
ty.externalAuth.pro

cessors.MTExternal
UserSetupProcessor
" 
parent="abstractEx
ternalProcessor"> 

<property 
name="organizatio

nRoleMap"> 

<map> 
<!-- Example of 
mapping customer 
roles to JRS roles --
> 

<entry> 
<key> 
<value>ROLE_ADM
IN_EXTERNAL_ORG
ANIZATION</value
> 
</key> 

<value>ROLE_ADM
INISTRATOR</valu
e> 
</entry> 

</map> 

All the Jaspersoft Roles are configured inside this 
tag. If any new Jaspersoft Roles are needed, they 
must be configured here. In the <entry> tag, the 
key value should match with the client role defined 
at the Keycloak end. 

Currently, the following roles are configured: 

1. Administrator 

2. Superuser 

3. User Role 

2. Copy the applicationContext-externalAuth-oAuth.xml file (edited in Step 1) 

to <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-INF. 
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3. Copy stc-jaspersoft-oauth-1.0.0.jar (available in the JRS distribution folder) to 
<JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/lib. 

4. Create and save a backup of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-

security.xml file. 

5. In <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/applicationContext-security.xml, replace the access value for the 

method 
com.jaspersoft.jasperserver.api.metadata.user.service.ProfileAttribut

eService.putProfileAttribute with ROLE_USER. 

6. Save a backup copy of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-security-

web.xml file again and replace the constructor-arg value for 

org.springframework.security.web.authentication.LoginUrlAuthenticationEntryPoin

t with /oauth. 

7. Add the SSL certificate used by Keycloak to the Java installation that Jaspersoft is 

using. (By default, Java only knows about a small number of root certificates.) To 

do this, follow these steps:  

a. Copy InstallCert$SavingTrustManager.class and InstallCert.class 

(both available in the STC Suite Distribution/Server Components/JRS 

directory) to the <JASPERSERVER_DIR>/java/bin directory. 

b. NOTE for sso-dev.stchome.com: This is only for Dev SSO SSL certificate 

installation. This URL changes based on your server hostname of the 

Keycloak/SSO server. 

c. Go to the <JASPERSERVER_DIR>/java/bin directory and execute these 

commands. The [sso_link] differs based on the environment; an example 

might be something like sso-dev.stchome.com. 

java -cp .\ InstallCert [sso_link] 

keytool -exportcert -alias [sso_link]-1 -keystore jssecacerts -

storepass changeit -file [sso_link].cer 

keytool -importcert -alias [sso_link] -keystore 

../lib/security/cacerts -storepass changeit -file [sso_link].cer 

8. Make database changes with the following commands. Jaspersoft stores all of its 

metadata in the Postgres database. All of the user-based profile attributes are 

stored in the jiprofileattribute table in Jaspersoft. By default, user attributes 

support a character size of 200. In Step E below, the data type size is changed 

from 200 to 1,000.  

a. Navigate to the <Jasper Installation Directory>/postgres directory. 

b. Run this command: psql -U postgres -W (the password is postgres). 

c. Now you should see at the prompt: postgres=# 
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d. Enter this command to connect to the Jasperserver database in Postgres: \c 

jasperserver; (the password is postgres). 

e. Execute this SQL alter script: ALTER TABLE jiprofileattribute ALTER 
COLUMN attrvalue TYPE character varying(100000); 

9. Restart the Jasper server and navigate to JasperUrl/oauth (see example). You 

should now be redirected to Keycloak to log in. Example: 
http://52.10.228.158:8080/jasperserver-pro/oauth 

Steps to Debug Issues Related to 
Keycloak/JasperReports Server Integration 

If there are any issues with integrating Keycloak with Jasper, follow these suggestions 

below. 

Check the applicationContext-externalAuth-oAuth.xml File 

Make sure that applicationContext-externalAuth-oAuth.xml is configured with the 

correct Keycloak and Jasper server parameters and with the correct client_secret. 

Keycloak Mappers 

Make sure that the Jasper client has the below mappers mapped correctly in Keycloak, 

and check if the Org/fac List mapper contains the correct parameters. (Note that your 

API-KEY and API-URI will differ from the image below. 
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Name Category Type 

org/fac list Token mapper Org/fac list 

email Token mapper User Property 

groups Token mapper Group Membership 

username Token mapper User Property 

realm roles Token mapper Realm Role List 

roles Token mapper Client Role List 

given name Token mapper User Property 

family  name Token mapper User Property 

full name Token mapper User's full name 

Validate the IWeb Web Service 

Make sure that the IWeb web service URL is accessible. The output of this should 

return the org/fac list. If there is an error, it needs to be fixed. 

 

Check the Whitelist Rules 

If Jaspersoft is installed in an AWS environment, the outbound connection on port 

8080 should be enabled for the IWeb server. 

If Keycloak is installed in an AWS environment, the outbound connection on port 8080 

should also be enabled for the IWeb server. 

Check the Firewall Rules 

If there are any special firewall rules preventing the Jasper and/or Keycloak servers 

from accessing IWeb through port 8080, the need to be fixed so that the port is 

enabled. 

JasperReports Server Upgrade - Windows 

These instructions are only required when deploying SMaRT AFIX for the first time or 

when upgrading from a version of SMaRT AFIX older than 1.17.4. If you have already 

deployed SMaRT AFIX 1.17.4, you should already have the web service plugin installed 

on your JasperReports server and can skip these instructions. 

As a part of SMaRT AFIX 1.17.4, the new SMaRT AFIX Online Tool web service was 

introduced to help support the CDC's AFIX Online Tool application. In order to integrate 

this tool with SMaRT AFIX, a plugin must be added to the existing JasperReports server. 
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Prerequisites 

1. JasperReports server has been installed. 

2. The web service plugin zip file has been downloaded to your application server 

(APP) and the contents extracted. The unzipped folder is referenced as $WS_DS 

from this point on. 

\APP\JRS\webserviceds_v1.0_3.zip 

3. Locate your JasperReports server web application folder, which is referred to as 

$JRS_HOME from this point on. It is recommended that you back up this folder 

before beginning the plugin installation. 

C:\Jaspersoft\jasperreports-server-6.2\apache-

tomcat\webapps\jasperserver-pro\ 

Plugin Installation Steps 

The installation should be performed as root user. 

1. Stop your web server running JasperReports server. 

2. Open the folder $WS_DS/JRS/WEB-INF/bundles and copy the contents to 

$JRS_HOME/WEB-INF/bundles/. Note that this should not overwrite any existing 

files. 

3. Restart the JasperReports server. 

Validation Steps 

Follow these steps to confirm that the plugin has been successfully installed: 

1. Navigate to your JasperReports server admin console. 
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2. Log in as an admin-level user. 

 

 

3. Select Create > Data Source from the top menu. 
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4. Confirm that Web Service Data Source is listed in the Type drop-down list. 

 

 

SMaRT AFIX JasperReports Deployment - 

Windows 

The following outlines how to import (migrate) Jaspersoft Reports for SMaRT AFIX. 

Pre-Migration Checklist 

 Confirm that the Postgres database is installed and configured 

 Retrieve the passwords for the SMaRT AFIX database (afixdb) 

 Retrieve the Jaspersoft superuser username and password 

 Confirm that the SMaRT AFIX Online Tool web service is installed 
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 Confirm that all necessary ports are open across all firewalls (the default port is 

80) 

 Confirm that the release distribution zip file for Jasper Reports is extracted from 

/APP/JRS/AFIX_Reports-[version number].zip and copied to your local drive. 

 Important: Be sure to update the JasperReports server by following the 

instructions in SMaRT AFIX JasperReports Server Upgrade - Windows. 

Procedure Steps 

Follow these steps to deploy Jaspersoft Reports. 

Export the Jaspersoft Repository for Backup 

Export the repository by selecting Manage > Server Settings > Export (Export 

Everything) in Jaspersoft. Save the file as a backup. 

 

Import the Content via the Portal 

1. Log in to the Jaspersoft BI Portal as the administrator user. 

2. Navigate to Server Settings > Import. 
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3. Import the AFIX_Reports-[version number].zip file. 

4. Update the data source with the database connection information. 

Import the Content via the Command Line 

1. Confirm that JAVA_HOME is set and your path includes jre\bin or jdk\bin. 

2. Change to the buildomatic directory on the JasperReports server: 
C:\Jaspersoft\jasperreports-server-7.1.1\buildomatic 

3. Execute the migrate command (adding in the correct version number): js-
import.bat --input-zip "AFIX_Reports-[version number].zip" --update -

-skip-user-update --include-access-events --include-audit-events --

include-monitoring-events 

4. Update the data source with the database connection information: From the left 

menu, go to root > AFIX > Data Sources. Select AFIX_AWS, then click the 

Edit tab. Specify your database connection properties for Host, Port, and 

Password, then click Save. 

 

. 

5. Select AFIX_EXPORT, then click the Edit tab. This is the web service data source 

linked to the SMaRT AFIX Online Tool web service. 
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6. Leave the defaults for Auth Type, Language, and Request Verb. Update the web 

service URI to point to your SMaRT AFIX Online Tool web service deployment. 

Note that even though the Password field is populated, no password is present or 

required; leave it as it is. Click Save when finished. 
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Validate the New Content 

The following steps perform a spot check on the newly created content to validate it and 

to check for any serious errors. It does not perform a full check of all possible issues and 

should be followed up with a functional validation of the content. 

1. Log on to the Jaspersoft BI server as a user able to run a report. The user should 

be able to log in successfully and see the subfolders under /root/AFIX (select 

View > Repositories). 
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2. Validate that the user can execute and view a report as defined by their class or 

organization membership: Select the report from 

AFIX/Reports/AFIX_Online_Tool, select one report from any of the other sub-

directories of AFIX/Reports, and confirm that both reports execute successfully. 

Restore the Previous Content (if Necessary) 

If there are any uncorrectable issues and the release upgrade needs to be aborted, follow 

these steps to revert to the previous content: 

1. Using the backup exported at the beginning of these steps, import using the steps 

above. Note that a re-import of the previous version of the content will also 

achieve the same back-out. 

2. Perform the validation steps listed above. 

Node.js Installation - Windows 

Node.js installation is not supported in Windows. 

SMaRT AFIX Application Installation 

Instructions - Windows 

The following instructions explain how to install the application, the Oracle Instant Client, 

Visual Studio 2013 Community Edition, Windows SDK v8.1, and Redis; how to configure 

the application dashboard and quick links; specific configuration options, and information 

on standalone versus multiple application deployment. 
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If you are upgrading from a previously installed version of SMaRT AFIX, you can skip 

directly to the Install the Deployment Package section and continue from there. 

Prerequisites 

The following should already be installed and configured: 

 Windows Server 2012 

 PostgreSQL server (DBB) 

 Oracle server (COR) 

 Node.js (APP)   

 PM2 (APP) 

Installation and Deployment of SMaRT AFIX, iQ, and 

VOMS 

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, you only 

need to install the Oracle Instant Client, Visual Studio, Windows SDK, and Redis with the 

first application installation. Once these are installed, for subsequent applications that 

are running on the same server, you can skip down to the Install the Deployment 

Package section and continue from there instead. 

Install the Oracle Instant Client 

1. Download Oracle Instant Client Basic and SDK for Windows. Extract Instant Client 

Basic somewhere on the disk (i.e., C:\oracle\instantclient_12_1), then 

extract Instant Client SDK into the same folder. 

2. Add the path you extracted Oracle Instant Client into to the PATH environment 

variable. This can be accessed via the Advanced System Settings window. 

3. Add the following system variables. (See https://github.com/oracle/node-

oracledb/blob/master/INSTALL.md#instwin and 

https://community.oracle.com/docs/DOC-931127 for more information.)  

 OCI_LIB_DIR to C:\oracle\instantclient_12_1\sdk\lib\msvc 

 OCI_INC_DIR to C:\oracle\instantclient_12_1\sdk\include 

Install Visual Studio 2013 Community Edition 

See https://www.visualstudio.com/en-us/news/releasenotes/vs2013-community-vs for 

download and installation instructions.   

https://github.com/oracle/node-oracledb/blob/master/INSTALL.md#instwin
https://github.com/oracle/node-oracledb/blob/master/INSTALL.md#instwin
https://community.oracle.com/docs/DOC-931127
https://www.visualstudio.com/en-us/news/releasenotes/vs2013-community-vs
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Install Windows SDK v8.1 

See https://developer.microsoft.com/en-us/windows/downloads/windows-8-1-sdk for 

download and installation instructions. 

Install Redis 

Use this command: 

msiexec /i Redis-x64-3.2.100.msi 

See https://github.com/MicrosoftArchive/redis and 

https://github.com/MicrosoftArchive/redis/releases/tag/win-3.2.100 for more 

information. 

Install the Deployment Package 

Copy the provided zip/tar file to the target server. Extract the archive and change into 

the parent of the directory where it was extracted. 

Configure the Application Dashboard and Quick Links 

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, the steps 

below only need to be completed the first time an application is installed. This file should 

be saved for all subsequent installations. 

1. Download the apps.json file from the release distribution application components 

shared folder. 

2. Edit this file with a text editor and replace the placeholders DASHBOARD_URL, 

IWEB_URL, AFIX_URL, PHC-HUB_URL, IQ_URL, and VOMS_URL (if applicable for 

your installation) with their respective URLs. 

3. Save this file and keep it handy as you will need to use it in the installation of iQ, 

VOMS, and the SSO dashboard. 

An example of one such configuration object in the JSON file is shown below. In most 

cases, only the URL value needs to change: 

{ 

"icon": "/static/public/img/STC - SmartAFIX.svg", 

"id": "AFIX", 

"name": "SMaRT AFIX", 

"url": "https://afix.stchome.com ", 

"description": "Utilized to make AFIX assessments efficient, standardized and 

meaningful.", 

"hideIfUnavailable": true, 

"accessRole": "Access_afix" 

} 

Copy this file to the following location: 

https://developer.microsoft.com/en-us/windows/downloads/windows-8-1-sdk
https://github.com/MicrosoftArchive/redis
https://github.com/MicrosoftArchive/redis/releases/tag/win-3.2.100
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<application_install_dir>/src/shared/helpers/appActions/ 

Configure the Reverse Proxy 

A reverse proxy is recommended to provide access to the various products. This is not 

explicitly required unless the products are running with the ENABLE_SSL option set to 

true. However, this will generally be the case when the products are being run in 

conjunction with IWeb on the same server. See the example Apache configurations at 

package/docs/apache. 

General Product Configuration Options 

Once the package containing the products has been installed, there are some 

configuration options that can be set depending on the environment. The majority of 

these lie in package/process.json, which is simply a JSON configuration file for pm2. 

The options listed in bold below need to be changed to match your environment. Other 

options not in bold might not need to change, and in most cases can be the default 

setting. Some options in the process.json file are not listed at all below; those options 

should be left unchanged. 

The options are as follows: 

Option Description 

script Location of the startup script application. The path to the script 
may need to be customized. 

cwd The path to the application. May need to be customized. 

PRODUCT The name of the product. 

HOST The host name for the product. 

APIHOST The host name of the product's respective API server (generally 
localhost). 

PORT The port for the product. 

APIPORT The port for the product's API server. 

NODE_ENV This should always be production. 

SAML_ISSUER The SAML issuer (client) from Keycloak. 

SAML_ENTRY_POINT The SAML entry point from Keycloak. 

JASPER_SERVER The domain name of the JasperReports server. 

REDIS_URL The Redis URL used for storing client sessions. 

REVERSE_PROXY When configuring SMaRT AFIX with a reverse proxy, this should be 
set to true. 

ENABLE_SSL When set to true, this enables HTTPS support.  If REVERSE_PROXY 
is set to true, this should be set to false even when the 
environment is configured for HTTPS. 
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Option Description 

SECRET_SESSION The secret key for session storage. IMPORTANT NOTE: This value 
must be exactly the same for every application, in both the server 
and the API environment variables. 

SMaRT AFIX-Specific Configuration Options 

The following options are specific to SMaRT AFIX configuration settings: 

Option Description 

VOMS_ORACLE_USER The username for IWeb's SIIS database. This is set to the 
default user for the SIIS, but may need to be updated 
depending on your configuration. 

VOMS_ORACLE_PASSWORD The password for IWeb's SIIS database. This is set to the 
default password for the SIIS, but may need to be updated 

depending on your configuration. 

VOMS_ORACLE_CONNECTION Connection information for IWeb's SIIS database. This needs 

to be updated to point to your IWeb's Oracle database 
instance. 

PG_USER The user account for the SMaRT AFIX PostgreSQL database. 

PG_PASSWORD The password for the associated PG_USER for the SMaRT AFIX 
PostgreSQL database. 

PG_HOST The hostname for the SMaRT AFIX PostgreSQL database. 

PG_PORT The port number for the SMaRT AFIX PostgreSQL database. 

AFIX_EXPORT_URI The URL for the SMaRT AFIX Online Tool web service. Only the 

hostname and possibly the port number for the URL need to be 
updated. 

AFIX_EXPORT_KEY The API Key for the SMaRT AFIX Online Tool web service. This 
should be left as the default. 

CDSI_FORECASTER_VERSION The current version of the CDSI Forecaster deployed. For the 
SMaRT AFIX 1.17.5.4 release, it should be set to 5.17.10. 

API_URL_PREFIX This should be set to /api 

SMaRT AFIX for Independent States-Specific Options 

These options are used for independent builds of SMaRT AFIX (i.e., not connected to 

IWeb) only and should be left unchanged for builds involving IWeb. 

Option Description 

API_URL_PREFIX This sets the API prefix for independent mappers. 

MANAGE_URL_PREFIX This sets the Manage Users page URL. 
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Option Description 

IS_INDEPENDENT When this option is set to true, it enables independent build 
functions. 

MANAGE_USER_EMAIL This enables the password reset functionality for the Manage Users 
page. 

SERVICE_API This enables custom report template sharing for independent 
SMaRT AFIX. It should be set to api/orgFacSearch. 

NOTE: Due to variations in the org-fac-micro-service between the different applications 
(SMaRT AFIX, VOMS, and iQ), it is recommended that you deploy the service that is bundled 
with SMaRT AFIX instead of the one bundled with other applications. 

Run the Application 

Use pm2 to run the deployment package as shown below. In many cases, environment-

specific configuration options must be set prior to running an application's package. See 

the configuration option sections above for more details. 

pm2 start package-parent/process.json 

Start the Products upon Bootup 

To have the products automatically start on every boot, do the following once it has been 

verified that they are running correctly: 

npm install -g pm2-windows-service 

pm2-service-install [-n service-name] 

pm2 save 
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Keycloak Configuration for 

SMaRT AFIX 
This task is to be performed during SSO installation of the application. The table below 

lists each application and component, along with the JSON file name, client name, and 

URL placeholder name for each. Make sure to use the correct file and other information 

corresponding to the specific application/component installation. 

Application Name JSON File Name Client Name URL Placeholder Name 

IWeb iweb.json iweb IWEB-URL 

PHC-Hub phchub.json phc-hub PHC-HUB-URL 

Jasper Report Server jasper.json jasper JASPER-URL 

iQ interop.json interop INTEROP-URL 

VOMS voms.json voms VOMS-URL 

Logviewer interop-logviewer.json interop-logviewer LOGVIEWER-URL 

Dashboard dashboard.json dashboard DASHBOARD-URL 

Import the Client and Roles (First Time 
Only) 

These steps explain how to import the client and configure the roles. 

Prerequisites  

The location of the JSON file for the application being installed. 

Import Steps 

1. Log in to Keycloak. 

2. Select the desired realm for the application suite in the top left drop-down list. 

3. Click Import on the left side menu. 

4. Click the Select File button and browse to the SMaRT AFIX release /SSO/JSON 

directory. 

5. Select the afix.json file and click Open. 

6. Important: In the If a resource exists drop-down list, select Skip. 

7. Select the afix_Provider_Group.json file and click Open. 

8. Important: In the If a resource exists drop-down list, select Skip. 

9. Select the afix_ManageUsers_Role.json file and click Open. 
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10. Important: In the If a resource exists drop-down list, select Skip. 

Configure the Client 

1. On the left side menu, click Clients. 

2. Locate the client named afix you just imported (see above) and click Edit. 

3. On the Settings tab, enter the URL to the application everywhere there is a URL 

placeholder. 

4. If the Client Protocol is SAML, expand the Fine Grain SAML Endpoint Configuration 

section at the bottom of the page and make sure the URL placeholders are 

replaced with the application URL. 

5. Click the Save button at the bottom. 

6. Click on the Mappers tab. 

7. Locate the user-type mapper and click the Edit button. 

8. In the API-URI box, replace the URL placeholder with the URL to your IWeb 

installation. 

9. Verify the API-KEY is set to the API key of your IWeb instance. 

10. Click the Save button at the bottom. 

Additional User Role for Independent 
States 

The SMaRT AFIX build for independent states requires an additional realm role called 

ManageUsers. Follow these instructions to add it: 

1. On the left side menu, click Roles. 

2. On the Realm Roles tab, click the Add Role button on the right. 

3. In the Role Name box, enter ManageUsers. 

4. For Description, select to allow Access Manage Users Page. 

5. Click the Save button at the bottom. 

6. Confirm that ManageUsers now appears in the Roles drop-down list. 

For independent states, a few management users must be configured in Keycloak. Once 

these users are set up, they can enable all other users on the Manage Users Page in 

SMaRT AFIX. The following steps can be performed only after the ETL jobs have 

completed and the users have been successfully migrated to Keycloak. 



 

  

SMaRT AFIX (v. March 2018) for Independent Partners Installation Guide Page 57 

 

1. In Keycloak, click Users in the left side menu. 

2. Either search for a management user by name in the Search box (click the 

magnifying glass icon to search) or click View all users and click on one of the 

users in the list. 

 

 

3. After selecting a user, the Users page refreshes with the selected user's 

information. Click the Role Mappings tab. Notice that the user has two roles 

assigned: offline_access and State. 
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4. From the Available Roles, select access_afix and ManageUsers, then click Add 

Selected to apply the roles to the user. 

 

 

5. Click the Credentials tab and update the user's password. You can set a default 

password if you want to, but whether you do or not, make sure to select Update 

Password in the Reset Actions drop-down list and then click Send Email. This 

sends an email to the user with a link to reset their own password. 

 

 

6. Repeat this process for every user that needs to have Manage Users access. 

Upgrade Instructions 

Before upgrading, make sure you know the location of the JSON file for the application 

being installed. 

Import Steps 

1. Log in to Keycloak 

2. Select the desired realm for the application suite in the top left drop-down list. 

3. Click Import on the left side menu. 

4. Click the Select File button and browse to the SMaRT AFIX release /SSO/JSON 

directory. 
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5. Select the afix_Provider_Group.json file and click Open. 

6. Important: In the If a resource exists drop-down list, select Skip. 

7. Select the afix_ManageUsers_Role.json file and click Open. 

8. Important: In the If a resource exists drop-down list, select Skip. 

 


